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Introduction
https://freeshow.app/docs/introduction

FreeShow is a free and open-source program to show slides and lyrics on a screen.

The project was started in late 2021, with the first release in February 2022.

The program was created because I couldn't find any free and good software to match the
expensive ones in features, usability and looks. I really wanted to make it as easy to understand
and use as possible. It might take some time getting used to, but I believe it will make the
process of creating and showing lyrics and media easy and fun.

FreeShow is available on Windows, macOS and Linux. It has many good features, and is still in
active development, so it should get more amazing and unique features.

If you haven't already, you can download the application from the homepage: freeshow.app

Get Started Using FreeShow
Video

YouTube video
https://youtu.be/9_1lUNcrU1w

Socials
• Tutorials on YouTube
• Community on Facebook
• Tips on Instagram
• QNA on Reddit

Reviews
• Capterra
• SourceForge
• GetApp
• AlternativeTo
• G2

https://freeshow.app/docs/introduction
https://freeshow.app
https://youtu.be/9_1lUNcrU1w
https://youtube.com/@freeshowapp
https://facebook.com/groups/freeshowapp
https://instagram.com/freeshowapp
https://reddit.com/r/freeshowapp
https://www.capterra.com/p/251606/FreeShow/
https://sourceforge.net/software/product/FreeShow/
https://www.getapp.com/nonprofit-software/a/freeshow/
https://alternativeto.net/software/freeshow/about/
https://www.g2.com/products/freeshow/reviews
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List of features
https://freeshow.app/docs/features

These are some of the main features.

• Languages: FreeShow supports English, Norwegian, Spanish, Slovak, Brazilian Portuguese,
German, Italian, Polish, Hungarian, Serbian, Slovenian, Ukrainian, Turkish, French, Russian,
Korean, Dutch, Chinese, Romanian & Czech.

• CMG Sans: Includes a beautiful font by Church Motion Graphics.
• Drawer: All the tools you need in one place.
• Projects: Project manager inside the application.
• Countdowns: Add custom countdown timers.
• Multiple outputs: Add as many outputs as you want, with easy control.
• NDI®: Send outputs over IP, useful for streaming.
• Output layers: Set and clear different layers: background/slide/overlays.
• Animations: Add custom animations to the items on your slides.
• Import: Text, ChordPro, PDF, PowerPoint, ProPresenter, EasyWorship, VideoPsalm, OpenLP,

OpenSong and more.
• Export: Export shows as text, PDF, or export an entire project.
• Backgrounds: Add backgrounds to your slides to make them stand out.
• Overlays: Have as many overlays as you want on top of any slide.
• Templates: Add templates to quickly change the style of your slides.
• Recorder: Mirror any screen or program on the computer to the output screen, and record

them.
• Player: Play YouTube & Vimeo videos directly in the program. More platforms may be added.
• Audio: Play one or more audio tracks, or microphones, and link them to your slides.
• Chords: Add chords to the text and show them in stage display.
• Lock Output: Lock the output to know for sure that you can't accidentally change the

output.
• Transitions: Add custom transitions for every single slide and items.
• Cloud Sync: Sync all your data between computers.

System requirements
The current version of FreeShow is built using Chromium 138, it should run on any
OS/hardware that can run a modern browser, check out the system requirements.

https://freeshow.app/docs/features
https://support.google.com/chrome/a/answer/7100626
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Install on Windows
https://freeshow.app/docs/windows

.exe
Download the .exe file and double click to install.

WinGet

BASH

winget install --id=ChurchApps.FreeShow  -e

This format is not regularly updated!

Check it out on winstall.app.

INFO
After launch, you might get an alert that the Firewall has blocked some features. If you
don't allow access, then you can't connect to the application remotely. This includes the
stage display, and remote controllers.

Application data path
For advanced users

JSON

%AppData%/freeshow

Older hardware
• Windows 7/8: Use version 1.2.4

https://freeshow.app/docs/windows
https://winstall.app/apps/ChurchApps.FreeShow
https://github.com/ChurchApps/FreeShow/releases/tag/v1.2.4
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Install on macOS
https://freeshow.app/docs/macos

.dmg
Step Action

1 Install — Double click the .dmg file

2 Copy — Drag the "FreeShow" icon into the "Applications" folder

3 Open — Find and open the app

INFO
After launch, you will be asked for permission to allow incoming network connections. If
you deny, then you can't connect to the application remotely. This includes the stage
display, and remote controllers.

Application data path
For advanced users

JSON

~/Library/Application Support/FreeShow/

Older hardware
• macOS 10.15: Use version 1.4.9
• macOS 10.14: Use version 1.2.4
• macOS 10.13: Use version 1.2.4

https://freeshow.app/docs/macos
https://github.com/ChurchApps/FreeShow/releases/tag/v1.4.9
https://github.com/ChurchApps/FreeShow/releases/tag/v1.2.4
https://github.com/ChurchApps/FreeShow/releases/tag/v1.2.4
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Understanding projects
https://freeshow.app/docs/projects

A project is a playlist with all the songs, videos, presentations and other elements for
your meeting.

Organizing
All of your projects are located in one place, inside the application, to make it quick and easy to
organize and find your projects. You'll see the projects on the left side when in "Show" mode.
And in the top you can see a "folder" icon, that when selected displays all of your folders and
projects. To add a folder click "New folder" at the bottom of the projects area. You can also have
folders inside folders.

TIP
I recommend creating a main folder for each event. Then have more folders inside with
the current year, if there are multiple events of the same kind each year, to keep it
organized.

Creating a project
Pressing the "New project" button next to the "New folder" button will create a new project. You
can drag it into a folder if you want. Click to select it, or double click to select and open.

Project templates
If you right click a project you can click "Create template" to create a template with the layout of
this project. This way you can create a structure that can be reused, and simply click on the
project template to create a new unique project with a preset structure!

https://freeshow.app/docs/projects
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Project
https://freeshow.app/docs/project-list

A project is a playlist with all the songs, videos, presentations and other elements for your
meeting. To add a new element you can drag it from the drawer, or drag a media file from the
computer directly. Drag elements inside the project to rearrange them.

To navigate between elements you can click them or press the arrow down/up buttons on the
keyboard.

Private shows
When a show is in a project you can right click on it and click "Private", all private shows will
have a lock icon and will not display in the shows list in the drawer. If that show has been added
to any other projects it will also be private there, but any changes will show in all the projects.

Sections
Click the button in the bottom of the project area to add a new section. Here you can add titles
for reference in your playlist, and add lots of notes.

TIP
Press CTRL/CMD + F to start searching in the drawer, and press enter to quickly add the
first result to the current project.

Project file
Go to File>Export>Project to export a .project file. This file is useful for transferring files between
computers. The project file is a .zip file and a .json file containing all of your media in the project,
including all shows/overlays/actions used.

Go to File>Import>Project to import a .project file.

You can also right click a project button/project title to export/import quicker.

https://freeshow.app/docs/project-list
https://freeshow.app/docs/drawer
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Showtime
https://freeshow.app/docs/show-type

A show is your slideshow. It can be song lyrics, events, presentations, images, bible
verses, and much more.

Creating a show
First you have to go to "Shows" in the drawer. At the bottom center you will find a New show
button. Clicking it will display a popup. Here you can type a name, and select a category the new
show will be placed in. The selected category will default to the currently opened category, or
the set category of the opened show. There are buttons for an empty show, web search for lyrics
and quick lyrics, which is recommended if you want to create song lyrics. The program will try to
apply groups automatically. Finally, once text is pasted/typed, press New show to create your
new show.

Quick Lyrics
Image

Screenshot of Quick Lyrics window
https://freeshow.app/images/docs/Show_type-Quick_Lyrics.webp

Syntax
Song Parts (Groups)
Parts of a song can be marked using the part name in square brackets (e.g. [Verse]). A group
will be created for each part. These groups can be added and removed from show layouts. This
makes it possible to have multiple "arrangements" of the same song parts/groups into different
layouts.

If there are multiple of the same song parts there is no need to add a number to the end of the
group name. FreeShow will by default automatically add numbers to the labels accordingly.

Here is a Quick Lyrics example song with two verses, chorus and bridge:

https://freeshow.app/docs/show-type
https://freeshow.app/docs/drawer
https://freeshow.app/images/docs/Show_type-Quick_Lyrics.webp


FreeShow Documentation

freeshow.app

[Verse]
Line 1
Line 2
Line 3
Line 4

[Chorus]
Line 1
Line 2
Line 3

[Verse]
Line 5
Line 6
Line 7
Line 8

[Bridge]
Line 1
Line 2

[Chorus]
Line 1
Line 2
Line 3

Image

Screenshot of Quick Lyrics example song with two verses, chorus and bridge
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_example_song_with_two_verses_chorus_a
nd_bridge.webp

Divide into slides with blank lines
Lines of a song part can be divided into separate slides by adding an empty line between the
song part lines. However normally this is not needed as you can also set how many lines are
display in the Styles section of the Settings. During the show presentation a progress indicator
will display below the song part slide to show how much of the song part has already been
displayed.

Here is an example of a verse with four lines that is divided so that the first two lines are on one
slide and lines three and four are on the second slide:

[Verse]
Line 1
Line 2

Line 3
Line 4

Image

Screenshot of a verse with four lines that is divided in two
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_divided_verse.webp

Metadata Import

https://freeshow.app/images/docs/Show_type-Quick_Lyrics_example_song_with_two_verses_chorus_and_bridge.webp
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_example_song_with_two_verses_chorus_and_bridge.webp
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_divided_verse.webp
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Metadata can be imported in Quick Lyrics by adding lines to the text box using the metadata
field name, an equal sign and the text that the metadata field should be set to (e.g. Title=Song
Title).

NOTE
For the Song ID (CCLI) field just use CCLI=.

Here is an example metadata import text:

Title=Song Title
CCLI=1234567
Copyright=© 2011 The Best Words Ever Sung; © 2011 ACME Song Factory LTD.
Author=John Doe | Jill Doe | Samuel Somebody

Image

Screenshot of Import Metadata Example
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_Import_Metadata_Example.webp

TIP
If you are adding a song title using the metadata import there is no need to enter a name
for your show, as it will default to the song title.

You can add custom metadata options in Settings>General>Manage metadata, that way
they can also be parsed from Quick Lyrics. For custom metadata fields with spaces, both of the
following lines will work:

custom title with spaces=Some Text
customtitlewithspaces=Some Text

Options
Under the Quick Lyrics text entry box is an Options button. Clicking on this will show the
following options.

Image

Screenshot of Quick Lyrics options
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_options.webp

NOTE
FreeShow will remember the settings for these options for future Quick Lyric imports.

TIP
If you normally copy your song text, metadata imports and then paste them into the
Quick Lyrics editor without editing them further or changing options, you can instead
after copying them press CTRL+ALT+I (MacOS CMD+OPTION+I) to instantly create a new
show.

Auto assign groups

https://freeshow.app/images/docs/Show_type-Quick_Lyrics_Import_Metadata_Example.webp
https://freeshow.app/images/docs/Show_type-Quick_Lyrics_options.webp
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If Auto assign groups option is on and square brackets are not used this will attempt to add
the most likely song part (group) based on how the song is structured (whether that is a verse,
pre-chorus, chorus or bridge). Otherwise, it will be placed in the default Verse group.

Format text
If the Format text option is on, it will auto capitalize the first letter in each line, remove trailing
white spaces and punctuations. And split long lines into multiple lines.

Max lines per slide
Entering a number into the Max lines per slide field will cause Quick Lyrics to auto split after
the requested number of lines breaking the song parts into multiple slides. This can better be
done by setting the maximum number of lines in the Styles section of the Settings.

Finding your shows
All your shows can be found in the "Shows" tab in the drawer. Here you can organize them into
different categories, the category changes the icon a show has in the project list. In the top right
corner of the drawer you will find a search bar to search through all of your shows. When a show
is opened or changed, the text content will be cached, so you can search by the content as well
as the title.

Slides
One group can have multiple slides. Right clicking a slide gives you different options.

One of them is to disable a slide, this can be useful if you might use a slide sometimes but not
always, or for more advanced uses. Keyboard navigation & slide timers will skip disabled slides,
but you can still click it to play as normal.

Presenting
When opening a show, you will by default get a "WYSIWYG" view, meaning the style of each slide
will match the style of the output. You can click any slide to show it, and use the arrow right/left
keys to change slides, or press spacebar. In the bottom of the show view you have some buttons
to change the layout of the current view.

TIP
Pressing spacebar at the end of a show will go to the next show in the current project.

Pressing the arrow keys will always change the slides of the current outputted show,
even when another show is active. But pressing spacebar will always play active show.

Backgrounds
Adding backgrounds are as easy as dragging them over any of the slides. Say you add a
background to the first slide, then that background will be applied to all the concurrent slides as
"ghost" backgrounds, meaning they behave the same as the first slide when clicked, but you can
only interact with the element on one slide. If you don't want any background to play on a
specific slide, you can right-click on the slide, choose "Slide actions", "Start action", and click
"Clear background".

https://freeshow.app/docs/groups
https://freeshow.app/docs/layouts
https://freeshow.app/docs/media#add-as-backgrounds
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TIP
If the background can't be found, e.g. the file is moved, or different computer, the
program will auto search and find any media with matching file name, as long as it's
inside a folder added to "Media" in the drawer.

Importing a show
If you have any existing lyrics from other programs, you can import them from the application
menu.

https://freeshow.app/docs/importing
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Different views
https://freeshow.app/docs/views

There are different types of views for a show, the default and best for presenting is the "Grid
view". They can be changed in the bottom center when a show is selected. Here is an
explanation of the different show views:

TIP
Right click on the view button to quickly change to any view.

Grid view
This is the most common view. Here you can see all of the slides as they are outputted in a grid.
Useful for presenting.

Simple view
This is a trimmed down version of the grid view. All the slide icons, labels, and also any disabled
slides are hidden.

List view
All of the slides from the grid view are shown on the left in a list, and on the right you can quickly
change the text of any textboxes on the slides. Useful for quick editing of typos.

Lyrics view
This is similar to the remote lyrics view, this is all of the text in a list without any formatting.
Useful if you want to sing along while presenting.

https://freeshow.app/docs/views
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Editing a show
https://freeshow.app/docs/editing

To edit a show, go to the "Edit" view in the top, with a show active. Here you can select any
slide, or add new on the left, change text and move/resize items in the center, and see more
tools on the right side.

You can zoom in/out or enable chords in the bottom center. And if you hold CTRL/CMD and
scroll up or down over the slides in the left panel you can show more slides at once.

TIP
Hold ALT and press Enter when the cursor is placed anywhere in a textbox to split the
text in two slides.

Tools
On the right side there are different tabs to edit the style of the slide or the contents, see under
for more information:

1. Item content
Edit the style of the text or content inside all items, or the current selected items.

2. Item style
Edit the item style of all items, or the current selected items.

3. Items
Add new items, or change the order current items.

4. Filters
Set filters for the slide, choose for either the background, the foreground or both.

5. Slide
Change the background color, or add notes to the current slide.

Item styling
Auto Size
When enabling the "Auto size" option, the text will be resized to fit inside the current textbox.
You can choose between two text fit options:

1. Shrink to fit: Text is set font size by default, but can shrink if the text does not fit in the
textbox. (default)

2. Grow to fit: Text will grow to fill the entire textbox, but maximum the set font size.

Text scrolling
When selecting a textbox you can choose to enable text scrolling if you want some effects.

CSS

https://freeshow.app/docs/editing
https://freeshow.app/docs/chords
https://freeshow.app/docs/items
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In some places there is a textbox to change the CSS directly. You don't need to use this if you
don't know it, but if you know CSS you can do many different special things with the browser
styling language.

Modes
At the bottom you can change the edit mode, first you can click on "Chords" to add chords. Also
you can toggle "Text edit".

Text edit
This works in a similar way to the "Quick lyrics" when creating a show, or it is the same if it is
empty. It will automatically change slides in the current layout based on the content of the text
after editing. It will update the content when the textarea loses focus (If you press esc, or click
on another area). Useful for copying/pasting song lyrics, and for splitting/joining slides.

Slides are seperated with an empty line, and labeled by [Group name]. And textboxes are
seperated with [#1], [#2], etc. Textboxes can also be marked with a language ID [#3:en].

Virtual line breaks (Virtual breaks)
This is a method of creating line breaks in some outputs but not in others at a given spot.

At the bottom of the editor you can press the more options arrow to reveal a button that will
insert these characters: "[_VB]" into the selected caret position. By default this behaves like a
normal line break.

But the power of this comes with using multiple outputs, in the output style settings you can
click the "Lines" option to open a popup, where you can find a toggle to "Skip virtual break", on
the outputs with this enabled the line will continue straight with no breaks. Often used in
addition to reducing the lines amount to 2.

https://freeshow.app/docs/chords
https://freeshow.app/docs/show#creating-a-show
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Items
https://freeshow.app/docs/items

There are different types of items you can add, depending on what you want to present.

After adding a new item, you can edit its properties on the right side, by clicking on the tab left
to "Item", and "Items" with the currently selected item name.

Here is a list of the items:

Text
This is the most common, and it is for adding text to a slide, or just a general shape.

Media
This is for adding images or videos to your slide.

Website
Load a website or a local html file. You can navigate this in the output window.

Timer
This is for adding a timer to your slide, that can be controlled from Timers under the "Functions"
tab in the drawer. You can also change the type to show a line or circle going from 100% filled to
0%.

Clock
Show the system time either analog or digital.

List
Create a list of different things that you can show as a list, or set a time so they can change
automatically.

Camera
Select a camera input feed.

Variable
Add a dynamic item to your slide. For creating and changing variables see this.

Progress
Add a progress meter to display the current slide progress. Choose between "Number"/"Progress
bar"/"Groups". "Groups" will show all the show groups and the currently active one. NOTE:
Ignore a group by prefixing it with "~"!

Events
This item will display upcoming events from the "Calendar" tab, either to a selected date, or
today/tomorrow etc.

Weather
Display weather forecast information by providing the latitude and longitude of the position.
Either show for the current day, or four days forward in time.

https://freeshow.app/docs/items
https://freeshow.app/docs/functions#timers
https://freeshow.app/docs/functions#variables
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Visualizer
Show a visualizer for playing audio. This will show some lines changing height depending on the
frequency and volume of the playing audio. Might cause some lag.

Captions
Add live speech to text captions to your slide.

Icon
This is for adding an SVG icon to your slide.

Dynamic values
Right click any item and choose, dynamic values to add any value that will change dynamically,
like the date, names, metadata, variables and much more.

TIP
Add "|" to the end to set a fallback value, example: show_name|No show (inside the
curly brackets).

Item actions
Right click any item, and choose "Item actions".

Line by line reveal
Add this option to only reveal one line at a time on slide click/next press. If "Click reveal" is set,
this will not start until that has triggered.

Click reveal
Add this option to reveal the item after a click/next press while the current slide is active.
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Adding chords
https://freeshow.app/docs/chords

When editing a show, you get a few buttons at the center bottom. One of them displays a "note"
icon with the label "Chords". Click on it to enable chords mode, this will display any existing
chords. In this mode you can click on any letter to add a chord, this will display a popup where
you can choose any chord.

Once you have added a few chords, you can select them in the bottom left to more quickly add
existing chords to your song. You can also quickly remove any chord by middle mouse clicking it.

Display chords on main display
To display chords on the main display, you have to select the textbox in the "Edit" tab, and
enable the "Chords" option on the right side. You can use a template, or the "Copy" option to
easily add the current item settings to all slides.

Display chords on stage display
To display chords on the stage display, you have to select the textbox in the "Stage" tab, and
enable the "Chords" option on the right side.

Transposing chords
FreeShow offers two different ways to transpose chords, each serving different purposes:

Global transpose (Show-level)
This method changes the chords in the show file itself, affecting all displays (main and stage)
that use this show.

How to use global transpose:

1. Go to the Edit page for your show
2. Click on Text edit at the bottom of the screen
3. Look for the up and down arrow buttons at the bottom of the text editor (just above the

bottom navigation bar)
4. Click the up arrow to transpose up a semitone or the down arrow to transpose down a

semitone
5. Continue clicking to reach your desired key

When to use: When you want to permanently change the key of a song, or when creating
different layouts for the same song in different keys.

Local transpose (Stage display only)
This method transposes chords only on the stage display device, without changing the original
show file. The transposition is stored in the browser cache and persists even if the stage display
is reloaded.

How to use local transpose:

1. Open the Stage display on your device

https://freeshow.app/docs/chords
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2. Ensure chords are enabled and visible
3. Click on the text box containing the chords
4. A transpose option will appear
5. Use the transpose controls to adjust the key up or down
6. To reset back to the original show key, set the transpose value to 0

When to use: When different musicians need the same song in different keys.
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Groups
https://freeshow.app/docs/groups

All the current groups are located at the right side of a show. One group can be a verse, and
another for chorus. A group can have multiple slides. Click or drag a group from the right to the
center to add it to your current layout. Changing the slide in one group, will change all of the
same groups in your layouts at the same time. Groups can be changed from the context menu.

NOTE
Editing a global slide in the editor will update all the slides in the layout that uses the
same group. Notice that a group with the same name can be added multiple times, and
will automatically be assigned a number. If you use the Text edit editor, the text you
input is what you get out, meaning any groups with the exact same text will be merged
into one, and any differences results in different groups.

None groups
Renaming a group to "." or setting it to the "None" option will mark it as a hidden group, which
will not show up in the groups list on the right. This can be useful for presentations, or if you
don't want the same group to be added multiple times.

Global groups
You can add global groups in the settings, when you edit a global group all of the slides with it
will update with the new name/color. You can also access these in the right "Groups" menu of
any show.

All global groups can also have a keyboard key linked to it, so say you set the letter "V" for
"Verse", this means that every time you press "V" on your keyboard it will play the first verse in
the selected show, or go to the next verse after the current outputted verse.

Group numbers
In the settings you can toggle a group numbers switch. When this is enabled all of the same
groups will automatically get a number based on their position. E.g. "Verse 1" and "Verse 2" if
they are different, or "Verse" and "Verse (1)" if they are the same.

TIP
Using the "Slide progress" item will show the current slide number, but can also be
changed to display all of the groups with a highlighted current group. If you want to hide
a certain group from this list, you can prefix it with "~".

https://freeshow.app/docs/groups
https://freeshow.app/docs/layouts

